
 
Chemistry 111 Laboratory 

Experiment 4:  Visualizing Molecular Orbitals with MacSpartan Pro 
(This experiment will be conducted in OR341) 

 
Introduction 
 
In class we have discussed Lewis structures, resonance, VSEPR, hybridization and molecular 
orbitals.  These concepts are useful for understanding chemical bonds and molecular shapes.  In 
this experiment you will have the opportunity to use the modern software MacSpartan Pro to 
draw molecules, calculate their optimum structures, and perform calculations to generate 3-
dimensional representations of molecular orbitals. 
 
The molecular orbital approach to chemical bonding (pp. 404-414 of Silberberg) is much more 
powerful than simpler approaches based on Valence Bond Theory (p. 393).  For example, the 
shapes of molecular orbitals can provide valuable insights into the fundamental question of what 
holds atoms together in chemical bonds.  In addition, molecular orbital calculations can predict 
the quantized energies of electrons in orbitals, magnetic properties of molecules, locations in 
molecules where electrons are most concentrated, and a variety of other critical molecular 
characteristics. 
 
This experiment will provide an opportunity for you to use computers and professional 
computational chemistry software to calculate and observe shapes of molecular orbitals of a 
variety of molecules.  We hope that you enjoy using the MacSpartan software as you gain a new 
perspective on molecular orbitals.  MacSpartan is a “common thread” through our chemistry 
curriculum since it is used for related applications in the organic, physical, and advanced 
inorganic chemistry courses at Macalester College. 
 
Drawing Structures and Calculations of Molecular Orbitals with MacSpartan 
 
The best way to learn about MacSpartan is to explore the software with different molecules.  
Let’s explore the molecule H2 and its molecular orbitals as a first example!  Address each 
question of this activity in a clear and organized way in your laboratory notebook.  The 
answers to these questions (bulleted) constitute your Experiment 6 laboratory report. 
 
It is always useful to draw the Lewis structure of a molecule before constructing it in the 
MacSpartan workspace.   
 

• Copy the analysis of dihydrogen from your ASA into your lab notebook. 
 
In the case of hydrogen, we are familiar with the energy level diagram and its molecular orbitals 
(p. 405 of our text).  Therefore, we know that its energy level diagram features two molecular 
orbitals (σ1s and σ*1s).  However, the total number of molecular levels can be calculated for any 
molecule by simply tallying the number of valence orbitals that each atom possesses.  Hydrogen 
only has one valence orbital (the 1s orbital).  When two hydrogen atoms combine to form 
molecular hydrogen, two molecular orbitals result from the combination of two atomic valence 
orbitals.  The application of this rule (sometimes called the Law of Orbital Conservation) will 
prove to be invaluable in this activity since it is impossible for MacSpartan to calculate all of the 
molecular orbitals for a molecule using a single command.  It is very useful to know how many 



 

 2

molecular orbitals one is expecting before starting a molecular orbital calculation using 
MacSpartan Pro. 
 
OK, now we are ready to draw the molecule! 
 

1. Select New from the File menu.  The Model Kit window will appear.  This is your palette 
for drawing essentially any chemical species (atoms, molecules, ions, or even groups of 
molecules/ions). 

 
2. In Entry mode (the palette default) of the Model Kit window, select the hydrogen atom.  

A tetrahedral carbon is generally selected initially when the palette is opened. 
 

3. Click once on the screen to place a hydrogen atom in the workspace. 
 

4. Now click on the “half-bond” of the hydrogen atom to attach the second hydrogen atom. 
 

5. Select Calculations… from the Setup menu.  The resulting window can be used to 
establish appropriate parameters for the calculation.  Under the “Calculate” heading 
select “Equilibrium Geometry” with “Semi-Empirical” and “AM1”.  The latter two 
terms refer to the type of calculation that will be employed.  “Initial geometry” should 
be indicated under the “Start from” heading.  The only other options that should be 
checked in the window are “symmetry” and “apply globally”.  Click OK once your 
selections in this window are complete. 

 
6. The goal of this calculation is to calculate the molecular orbital surfaces of hydrogen.  

Our next step is to request the orbitals we want to examine.  Select Surfaces under the 
Setup menu.  A “Surfaces” window will appear.   

 
7. In the Surfaces window, click on “Add”.  Now we need to select the orbitals we want to 

calculate.  Under “Surface”, select HOMO and then OK.  HOMO should appear in the 
surfaces window.  HOMO is shorthand for Highest Occupied Molecular Orbital.  This is 
the orbital of highest energy for a molecule that contains electrons.  We already know 
that the hydrogen molecule only has one occupied molecular orbital (σ1s) so this is also 
the HOMO.  The empty molecular orbital that is closet in energy to the HOMO is called 
the LUMO (Lowest Unoccupied Molecular Orbital).  This is also called σ1s

* for our 
hydrogen molecule.  To select LUMO, click on “Add”, choose LUMO from the 
“Surface” heading, and then click OK.  Both hydrogen molecular orbitals should now be 
listed in the Surfaces window. 

 
8. Now we are ready to start the calculation!  Select Submit under the Setup menu.  Since 

this is the first time you are using MacSpartan today, you will be asked to save your 
molecule.  Use your name or a similarly generic tag to name your file, as the same name 
will be used throughout this experiment.  Click on Save, then click OK to acknowledge 
that the calculation has started.  Click OK again when the calculation has completed. 

 
9. Before we examine the molecular orbitals, let’s “play” with our optimized hydrogen 

molecule to learn more about MacSpartan Pro.  (You can skip this if you remember it!) 
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10. Enlarge/Reduce the Molecule:  Depress the option and apple keys simultaneously while 
dragging the mouse in the appropriate direction to achieve the desired effect. 

 
11. Molecule Representation:  The way in which a molecule is displayed can be changed by 

switching between the “wire”, “ball and wire”, “tube”, “ball and spoke”, and “space 
filing” options under the Model menu.  Try out these different options for fun. 

 
12. Move the Molecule:  Depress the mouse and option key simultaneously while moving the 

mouse. 
 

13. Rotate the Molecule in the X/Y Plane:  Click on the background and drag the mouse in 
the desired direction. 

 
14. Rotate the Molecule in the Z Plane:  Depress the mouse and apple key simultaneously 

while dragging the mouse in the desired direction. 
 

15. Now let’s look at the molecular orbitals!  In the Surfaces window (if you’ve closed it, 
bring it up by selecting Surfaces under the Display menu), select the HOMO box: the σ1s 
molecular orbital should appear.  Note that the same mouse/keyboard functions described 
earlier can be used to move, rotate, or scale these orbitals. 

 
16. The orbitals can be displayed in different ways as well.  Click on the molecular orbital to 

select it (a yellow circle will appear around it).  Select Properties under the Display 
menu.  Adjust the “style” from “solid”, “dots”, “transparent” and “mesh” (my personal 
favorite) to examine your options.  Note that the “Properties” window can be toggled 
between “Surface Properties” and “Molecule Properties” by clicking on the orbital or the 
background.  In this experiment, we will only need to use the “Surface Properties” 
window. 

 
17. When you are finished examining the σ1s orbital, go back to the “Surfaces” window 

(Surfaces under the Display menu).  Deselect HOMO and choose LUMO to display the 
σ1s* orbital.  Note that both the HOMO and LUMO can be displayed simultaneously if 
desired. 

 
18. Notice the node between the two hydrogen nuclei in the LUMO.  This is a diagnostic 

feature of a σ antibonding orbital.  The software employs different colors to indicate 
lobes with opposite wavefunction signs (these waves destructively interfere when the 
atomic orbitals come together and the result is a node - a region of zero electron density).  
In this case, one lobe is blue while the other is red.  In the case of the HOMO, there is no 
node between the nuclei and the molecular orbital features the same wavefunction sign 
throughout (all the same color).  The HOMO is classified as σ bonding since electron 
density exists in the area directly between the nuclei.  This is the orbital that is 
responsible for the single bond in hydrogen. 

 
• Construct an energy level diagram for hydrogen in your laboratory notebook.  

(include the appropriate hydrogen atomic orbitals on the left and right with the resulting 
molecular orbitals in the center).  Label each molecular orbital using both the scheme 
provided in Chapter 11 and the scheme used by MacSpartan Pro (HOMO/LUMO).  
Include the appropriate orbital electron occupation in your diagram.  Finally, sketch each 
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surface adjacent to the corresponding energy level.  Shade your lobes (or leave them 
unshaded) to indicate different wave function signs. 

 
• How does your electron classification based on the H2 Lewis structure compare with the 

results of the molecular orbital analysis (i.e., do the sigma, pi, and nonbonding electron 
counts agree between the two methods)?  Explain. 

 
 22. When you are completely finished with hydrogen and its orbitals, delete your molecule by 

choosing Select All and then Cut from the Edit menu.  (If Select All is greyed out, click 
on the green background screen to activate it.)  You might see some funny stuff on the 
screen, but it should disappear when you click on the + button, or select Add Fragment 
from the Build menu,  We strongly recommend AGAINST (further) use of using Open, 
Close, or New on the File menu.  We also advise against using Clear on the Edit menu, 
since using that will clear out the surfaces menu.  The suggested approach keeps the 
surfaces you have already enetered, which saves a lot of time in this lab! 

 
Let’s proceed to other molecules!  We’ll start with the same general protocol. 
 
N2 

 
• Copy your analysis of dinitrogen from your ASA into your lab notebook. 

          
Draw a molecule of nitrogen in the workspace using the same general protocol employed for 
hydrogen (start with #2 of the previous list).  Your Lewis structure should clearly indicate which 
atoms you need to connect from the Model Kit “Entry” window.  All selections should be the 
same in the “Calculation” window as they were for hydrogen.  Add the following orbital labels 
to the “Surfaces” window before submitting the calculation: LUMO+14, LUMO+13, 
LUMO+12, LUMO+11, LUMO+10, LUMO+9, LUMO+8, LUMO+7, LUMO+6. LUMO+5, 
LUMO+4, LUMO+3, LUMO+2, LUMO+1, LUMO, HOMO, HOMO-1, HOMO-2, HOMO-3, 
HOMO-4, HOMO-5, HOMO-6, HOMO-7, HOMO-8, HOMO-9, HOMO-10, HOMO-11, 
HOMO-12, HOMO-13, HOMO-14.  Sorry, I know the entry system is a pain, but there’s no 
faster way.  This list consists of many more molecular orbitals than dinitrogen actually has, but 
by enetering all of these now you avoid having to worry about adding anything further to the 
Surfaces window as you go through the lab.  Non-existent orbitals will not be calculated by 
MacSpartan, and simply show up as “pending,” even after you Submit the molecule for 
calculation. 
 
Examine each occupied orbital surface in dintrogen and then answer the following questions: 
 

• Sketch all of the molecular orbitals calculated by MacSpartan, (with appropriate shading 
of the lobes) and classify each as σ, σ*, π, π* or n (nonbonding).  A nonbonding 
molecular orbital is one that is neither bonding nor antibonding in character.  For a 
diatomic molecule, a nonbonding molecular orbital features an unchanged atomic orbital 
on one of the molecule’s atoms.  Although every energy level diagram features bonding 
and antibonding molecular orbitals, nonbonding orbitals are less pervasive. 

 
• How are the LUMO and LUMO+1 orbitals related to each other?  HOMO-1 and HOMO-

2? (HINT: Examine these orbital surfaces simultaneously.)  What term describes sets of 
orbitals that are related in this fashion? 
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• Construct an energy level diagram for nitrogen (include the appropriate atomic orbital 

energy levels and labels on the left and right, and place the appropriate molecular orbital 
energy levels in the center).  Label each molecular orbital using both the designations 
used by MacSpartan (HOMO-4, etc.) and the standard nomenclature (σ, π, etc.).  Indicate 
the electron occupation in your diagram as well. 

 
• How do your molecular orbital results compare with your previous responses based on 

the Lewis structure of nitrogen?  Are the Lewis structure and Molecular Orbital 
approaches more compatible for hydrogen or nitrogen? 

 
Remember, the best way to get rid of N2 and prepare for working on your next molecule is Select 
All and then Cut from the Edit menu, followed by Add Fragment from the Build menu. 
 
Let’s try CO next!   
 

• Copy your analysis of carbon monoxide from your ASA into your lab notebook. 
 
It is best to use the “Expert” mode within the Model Kit window for building carbon monoxide.  
Begin by selecting carbon as the “element.”  Select the “–X” box, since carbon is only linked to 
one other atom in CO.  Click on the workspace to add this carbon.  Then, select the type of bond 
that carbon makes to oxygen in your Lewis structure from the choices in the third row of 
rectangular options, and double-click on center of the bond to change it to the correct type.  
Next, change the element to oxygen by clicking on the element box, and then click on the 
existing bond from carbon to add it to your structure (the other parameters should remain 
unchanged). 
 
The rest of the procedure can be followed as before.  Be sure to Submit your molecule for 
calculation, and then carefully examine each orbital. 
 

• Sketch the shapes of the π and π* orbitals of carbon monoxide and provide their 
MacSpartan Pro labels (HOMO-4, etc.).  Compare these orbitals with the π and π* 
orbitals of N2.  Account for the difference in the shapes of these orbital sets for these two 
molecules.  (HINT: Consider electronegativity!) 

 
• On the basis of the molecular orbitals, account for the triple bond in this molecule (i.e., 

Which orbitals are occupied and what bond order does this suggest?). 
 
Our world would be pretty boring if it only contained diatomic molecules!  Let’s try some 
molecules that are more sophisticated! 
 
O3   
 

• Copy your analysis of ozone from your ASA into your lab notebook. 
 
The concept of resonance is more readily understood using molecular orbital theory than it is 
with Lewis structures.  The resonance structures for ozone indicate that two electrons are 
delocalized simultaneously over both oxygen-oxygen linkages.  We first need to envision 
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electrons as waves and not particles if we hope to conceptualize this idea.  Particles are 
inherently “localized” while a wave can be spread out between two points (or in this case, 
between three atoms). 
 
For electrons to be delocalized over more than two atoms, a molecular orbital must be available 
that extends over the atoms involved.  We typically think about delocalization involving π 
orbitals.  Let’s treat ozone with molecular orbital theory and discover the molecular orbital that 
permits its two electrons to “spread out” over all three oxygen atoms.   
 
Ozone is best built in the “Expert” mode of the Model Kit window.  Select oxygen as the 
element.  Now select the icon from the first two rows that best represents the geometry around 
the central oxygen atom.  Insert the central oxygen atom, and then adjust the bonds to indicate 
that the oxygen-oxygen bonds formally possess a bond order of 1.5 by selecting the line + 
dashed line icon and double-clicking on the centers of the two half bonds on your oxygen.  (This 
bond order can be deduced by examining the ozone resonance forms.) 
 
The terminal oxygens can be added by changing the “X” icon to “-X” and clicking on the half 
bonds in the workspace.  (You don’t have to worry about setting the bond type, as these are 
automatically matched to the half-bond you click,)  You may need to rotate the central fragment 
first to permit easy access to its half-bonds.  Once you have built ozone, Submit it. 
 
Examine each molecular orbital.  It is sometimes helpful to change the “percentage of the surface 
displayed” for these orbitals to ease their classification.  To do this for an orbital, select 
“Properties” under the Display menu when a molecular orbital surface is in the workspace.  We 
are interested in the surface properties window.  Adjust the “Isovalue” to 0.070 for an ozone 
orbital.  Hit return to cause the isovalue change.  This lowers the percentage of the displayed 
surface.  Feel free to adjust the isovalue to facilitate your classification of any surface. 
 

• Which molecular orbital best accounts for the delocalization of π electrons in this 
molecule?  Provide the corresponding label (i.e., LUMO+1, etc.) and sketch the orbital 
below.  Which oxygen atomic orbitals constructively interfere to generate this molecular 
orbital? 

 
Let’s try ethylene next!  
 
C2H4  
 

• Copy your analysis of ethylene from your ASA into your lab notebook. 
 
Generate this molecule using the “Entry” mode of the Model Kit window.  Calculate and inspect 
its molecular orbitals. 
 

• Identify and sketch all the π and π* orbitals of ethylene.  Be careful when making your 
selections- the “mesh” display mode might be most helpful as you examine each orbital 
and make your classifications. 

 
• Would you expect the CH2 groups to rotate freely about the C=C bond?  Why or why 

not? 
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C2H2  
 

• Copy your analysis of acetylene from your ASA into your lab notebook. 
 
Generate this molecule using the “Entry” mode of the Model Kit window.  Calculate and inspect 
its molecular orbitals. 
 

• Identify and sketch all the π and π* orbitals of acetylene.  Indicate the relative 
orientations of these orbitals in your sketches. 

 
C6H6   
 

• Copy your analysis of benzene from your ASA into your lab notebook. 
 
Benzene is trivial to construct if one selects it from the rings list in the “Entry” mode of the 
Model Kit window.  Click on the screen to add benzene to the workspace. 
 

• Which orbitals in benzene are involved in π bonding?  Provide the label for every 
molecular orbital of benzene that is either π or π* (both occupied and unoccupied). 

 
• Sketch the lowest energy π molecular orbital.  How does this orbital account for the 

delocalization of π electrons in benzene? 
 
 
We haven’t done any charged species yet.  Let’s try the polyatomic nitrate anion as our last 
example! 
 
NO3

-  
 

• Copy your analysis of nitrate ion from your ASA into your lab notebook. 
 
Construct this molecular ion using the appropriate icons in the “Expert” mode of the “Model 
Kit” window.  Use the same bond type that was used for ozone since these species feature 
delocalization of π electron density (both ozone and benzene also possess bonds of formal 1.5 
bond order).  The only difference in the setup process from the other molecules in this activity is 
that you will need to indicate that this is an Anion in the “Total Charge” prompt of the 
“Calculations” window. 
 
Calculate and inspect the molecular orbitals of nitrate ion: 
 

• Which of these molecular orbitals permits the most effective delocalization of its π 
electrons?  Sketch this molecular orbital and provide its label. 

 
• Which σ molecular orbital is lowest in energy?  Sketch this molecular orbital and provide 

its label.  What distinguishes this surface from the other σ molecular orbitals? 
 
Please Log Out of your computer when you are finished.  To do so, click on the smiley face icon 
furthest to the right in the “Dock” at the bottom of the screen, then pick Log Out Macalester… 
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from the Apple menu.  Logging out will remove all the files and folders you generated while 
using the computer, so don’t worry about “cleaning up” before you do so.  Thanks! 
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Name_____________________________ 

 
Experiment 4:  Visualizing Molecular Orbitals with MacSpartan Pro 

Advance Study Assignment 
 
Please provide the answers to the following questions on this sheet of paper.  You should 
complete this ASA before you arrive for your lab. 
 
For each of the following molecules, do or answer the following: 

a. Draw the Lewis structure, including relevant resonance forms 
b. Indicate the bond order(s) in your molecule 
c. Indicate the number of valence electrons that populate the molecular orbitals of the 

molecule 
d. Based on your Lewis structure, how many of these electrons are classified as sigma (σ) 

type?  (HINT: The first bond between any two atoms is sigma; additional bonds are pi!) 
e. Based on your Lewis structure, how many of these electrons are classified as pi (π) type? 
f. Based on your Lewis structure, how many electrons should be classified as nonbonding?  

(HINT: Nonbonding electrons are represented as lone pairs in a Lewis structure) 
g. How many total molecular orbitals do you anticipate for this molecule? 

(HINT: The total number of molecular orbitals can be calculated for any molecule by simply 
tallying the number of valence orbitals that the atoms in the molecule possess.) 

 
The dihydrogen molecule (H2) is done for you here as an example: 
 

a. H H 
b. B.O. = 1  (2 bonding 

electrons / 2 = 1) 
c. 2 valence e- 

d. 2 σ e- (in the one single bond) 
e. 0 π e- (there are no double or triple bonds) 
f. 0 nonbonding electrons (no lone pairs)  
g. We anticipate 2 MO’s  (each H atom brings one 1s 

valence orbital to the table) 
 
Now it’s your turn!  Start with an analysis of dinitrogen, N2: 
 
 
 
 
 
 
 
Now, that wasn’t too bad, right?  Of course, it gets harder.  Try carbon monoxide, CO: 
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Hey, you’re getting good at this!  Give ozone (O3) a whirl: it is NOT a ring, it’s a bent molecule! 
 
 
 
 
 
 
 
 
Next, give ethylene a whirl (C2H4): 
 
 
 
 
 
 
 
On a somewhat similar note, try acetylene next.  It’s C2H2: 
 
 
 
 
 
 
 
Now things get a bit harder.  Give benzene your best shot.  It is C6H6, and consists of a ring of 
six carbon atoms.  It has a large number of molecular orbitals, but certainly not too many to 
count! 
 
 
 
 
 
 
 
 
 
 
 
 
Lastly, perform the same analysis on the familiar nitrate ion (NO3

-).  You learned in the previous 
lab that the central atom has a steric number of three, and that the nitrate ion exhibits resonance. 


